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Abstract
Type your abstract paragraph here, 150-250 words. Do not indent. After typing the abstract, insert a page break; the body of the paper will begin on the following page. The abstract should be accurate, nonevaluative, readable, and concise. This is the single most important paragraph of the paper. 
On the Home tab of the tool bar of the version of Microsoft Word that you are using, check out the styles gallery for a collection of text styles formatted to match APA requirements (see above).  The headers on the cover and continuation pages are also set up for APA standards; to add your title to the header, tap Header & Footer on the Insert tab.  For more information about APA formatting requirements, please consult the Publication Manual of the American Psychological Association (APA), 6th Edition.
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Repeat Title Here, up to 12 Words, 1-2 Lines
The body of your paper (Normal Style) uses a half-inch first-line indent, and is double-spaced. Note that the word Introduction is not used as an initial heading, as it is assumed that your paper begins with an introduction. 
The introduction is to provide the background of the study. This includes an explanation of the area of your research to set up a context for the problem you will be exploring. The introduction also includes a detailed literature review in which you (a) explain what previous studies have stated about the topic; (b) discuss recent developments related to the topic; and (c) identify the gap in the literature that has led to your study. Also explain the problem that the study addresses and give a brief account of the history of the problem, including whether it has been addressed in any form before. 
The suggestions and comments in each of the following sections are adapted from the work of Price, Jhangiani, and Chiang (2014). For the in-text citations, refer to any APA guide style document. There are plenty of examples on the web, such as https://owl.purdue.edu/owl/research_and_citation/apa_style/apa_formatting_and_style_guide/general_format.html.
Here’s how to format your headings:

First-Level Heading
The main parts of the article are separated by fist-level headings like the one above.
This Is a Second-Level Heading for the Introduction (the first-level heading is assumed, as explained above)
This is used in case you need to divide a paragraph into subsections. You are free to use as many headings as you need in the introduction. It is a good idea to mark paragraphs dealing with different subjects with their own heading, as this helps the reader get the general flow of the article.
This is a third-level heading for the introduction. Third-level headings end with a period (.), and the paragraph text continues inline after the heading.
The Present Study
The end of the introduction – typically the final paragraph or two – usually includes two important elements: (a) a clear statement of the main research question or hypothesis, often expressed in terms of operational definitions of the key variables; and (b) a brief overview of the method used and some comment on its appropriateness.
Method 
Participants
The Method section is where you describe how you conducted your study. An important principle for writing a method section is that it be clear and detailed enough so that other researchers are able to replicate the study by following your “recipe.” This means that it must describe all the important elements of the study, including basic demographic characteristics of the participants, how they were recruited, whether they were randomly assigned, how the variables were manipulated or measured, how counterbalancing was accomplished, and so on. The Participants subsection specifies how many participants were involved, the number of women and men, some indication of their age, other demographics that may be relevant to the study, and how they were recruited, including any incentives given for participation.
Design
The design of a study refers to the overall structure of the study. What were the independent and dependent variables? Was the independent variable manipulated and, if so, was it manipulated between or within subjects? How were the variables operationally defined?
Procedure
The Procedure section relates how the study was carried out. It often works well to describe the procedure in terms of what the participants did rather than what the researchers did. For example, the participants gave their informed consent, read a set of instructions, completed a block of 4 practice trials, completed a block of 20 test trials, completed 2 questionnaires, and were debriefed and excused.
Results
It is important that the results section is logically organized. Typically, it begins with certain preliminary issues, including the following: (a) whether any participants or responses were excluded from the analyses and why. The rationale for excluding data should be described clearly so that other researchers can decide whether it is appropriate; (b) how multiple responses were combined to produce the primary variables in the analyses; (c) how reliable the measures were. This is where you would present test-retest correlations, Cronbach’s α, or other statistics to show that the measures are consistent across time and across items; and (d) whether the manipulation was successful. This is where you would report the results of any manipulation checks. 
The Results section should then address the primary research questions, one at a time. Again, clear organization is critical. One approach would be to answer the most general questions and then proceed to answer more specific ones. Another option would be to answer the main question first and then secondary ones.
Bem (2003) suggests the following basic structure for discussing each new finding:
Remind the reader of the research question.
Give the answer to the research question in narrative text.
Present the relevant statistics.
Qualify the answer if necessary.
Summarize the result.
Discussion 
The discussion typically begins with a summary of the study that provides a clear answer to the underlying research question.  This is often followed by a discussion of the theoretical implications of the research. Do the findings provide support for any existing theories? If not, how can they be explained? Although you do not have to provide a definitive explanation or detailed theory for your results, you need to outline one or more possible explanations. Applied research studies – and often basic research as well – also include some discussion of the practical implications of the research, such as how can the results be used, and by whom, to accomplish some real-world goal?
Implication for practice
Given the practice-oriented focus of this journal, authors are encouraged to include a section outlining the practical implications of their findings. In this section, explain how the results of the study may inform professional practice, educational interventions, program design, policy, or applied decision-making within the relevant field.
Authors should clearly describe how practitioners (e.g., educators, psychologists, administrators, or other professionals) may apply the insights from the study in real-world contexts. When possible, provide concrete examples, recommendations, or strategies derived from the findings. Implications should be grounded in the results of the study and should not extend beyond what the evidence reasonably supports.
Conclusion
The conclusion of an APA paper is the final paragraph where you restate your thesis and tie together supporting ideas you have referenced, spelled out, and argued for in earlier paragraphs. Don’t just restate the information. Instead, put it into logical order in the body of your paper, illustrating the connections between each piece that reinforce your research.
Limits of the Study 
In this section you may discuss the study’s limitations. Perhaps there are problems with its internal or external validity. Perhaps the manipulation was not very effective or the measures not very reliable. Perhaps there is evidence that participants did not fully understand their task or that they were suspicious of the intent of the researchers. Now is the time to discuss these issues and how they might have affected the results.]
Implications for Further Research
Most discussions end with suggestions for future research. If the study did not satisfactorily answer the original research question, what will it take to do so? What new research questions has the study raised? This part of the paper is a discussion of two or three of the most important unresolved issues.
Ethics and Consent (if applicable)
Given the multidisciplinary nature of the Continuity of Education journal, two different types of ethics and consent codes are applicable, depending on the nature of the reported activity. The journal's ethics and consent guidelines are available here (https://continuityineducation.org/about/ethics-and-consent).
Use of Artificial Intelligence
Authors should disclose whether and how Artificial Intelligence (AI) tools were used during the preparation of the manuscript. 
Acceptable uses of AI include:
Language editing and grammar correction
Improving clarity, readability, or organization of text
Formatting references or manuscript structure
Generating wording suggestions or summarizing draft text written by the authors
AI tools must not be used to:
Generate or manipulate original research data (including images, measurements, or datasets)
Fabricate references, citations, or empirical findings
Produce substantive sections of the manuscript without meaningful human intellectual contribution
Replace the analytical or interpretive work of the authors
Authors remain fully responsible for the accuracy, integrity, and originality of the manuscript.
Example 1 of a disclosure statement:
A generative AI tool (e.g., ChatGPT, Claude, Perplexity) was used to assist with language editing and to improve the clarity of the manuscript. All content was reviewed and verified by the authors, who take full responsibility for the final text.
Example 2 of a disclosure statement: 
The conceptual ideas and research content of this article were developed solely by the authors based on their professional judgment, expertise, and experience. A generative AI tool (name the tool) was used only to obtain suggestions for improving the organization and readability of the manuscript. The AI system was not used to generate research content, data, analyses, or references.
Example 3 of a disclosure statement: 
An AI-based writing assistant (name the tool) was used to identify grammatical issues and improve sentence clarity. All suggested revisions were carefully reviewed by the authors, who ensured the accuracy and originality of the manuscript. No research content, data, analyses, or references were generated using AI.
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Supplementary Files (optional)
List any supplementary/additional files that need to link to the main publication, with a corresponding number, title, and optional description. Ideally, cite the supplementary files in the main text.
Example: Supplementary File 1: Appendix. Scientific data related to the experiments.
Note. Additional files will not be typeset, so they must be provided in their final form. They will be assigned a DOI with a link to the publication.
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Note.  [Place all tables for your paper in a tables section, following references (and, if applicable, footnotes).  Start a new page for each table, include a table number and table title for each, as shown on this page.  All explanatory text appears in a table note that follows the table, such as this one.  Use the Table/Figure style, available on the Home tab, in the Styles gallery, to get the spacing between table and note.  Tables in APA format can use single or 1.5 line spacing.  Include a heading for every row and column, even if the content seems obvious.  A default table style has been setup for this template that fits APA guidelines.  To insert a table, on the Insert tab, click Table.]


Figures title:

Figure 1. [Include all figures in their own section, following references (and footnotes and tables, if applicable).  Include a numbered caption for each figure.  Use the Table/Figure style for easy spacing between figure and caption.]
For more information about all elements of APA formatting, please consult the APA manual, 6th edition.
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